
Tribometrics

Version 2.22.0409



Surface Machine Systems

2

Table of Contents
Tribometrics .................................................................................................1
Version 2.22.0409 ........................................................................................... 1
1. About This Document .................................................................................. 4
1.1. Conventions .............................................................................................4
2. Introduction ..............................................................................................5
2.1. Software Features ..................................................................................... 5
2.2. Automatic Scratch Visualization Overview .........................................................6
2.3. Hardware Requirements .............................................................................. 6
3. Parts Description ........................................................................................7
4. Installing the Software ................................................................................. 8
4.1. Installation Requirements ............................................................................ 8
4.2. Installation Directions .................................................................................8
5. Using the Tribometrics Software ................................................................... 10
5.1. Starting the Software ................................................................................ 10
5.2. The Main Interface ................................................................................... 10
5.2.1. Primary Features ................................................................................... 11
5.3. Overview of Operation ...............................................................................11
5.4. Acquiring a Specimen Image ........................................................................12
5.4.1. Open An Existing Image ........................................................................... 12
5.4.2. Acquire an Image from a scanner ................................................................12
5.5. Sizing Images .......................................................................................... 16
5.6. Configuring Specimen Color Calibration .......................................................... 17
5.7. Creating a Scratch Profile ...........................................................................18
5.8. Reviewing Scratch Profiles .......................................................................... 20
5.9. Updating Scratch Profiles ........................................................................... 21
5.10. Delete a Scratch Profile ............................................................................21
5.11. Setting Scratch Analysis Parameters ............................................................. 21
5.12. Analyzing a Scratch Specimen .....................................................................21
5.12.1. Analysis Options ...................................................................................22
5.12.2. Proportional Visibility Scratch Analysis ....................................................... 23
5.12.3. Ford 5-Finger Gauge ..............................................................................23
5.12.4. Mar ..................................................................................................24
5.12.5. Proportional Visibility Mar Analysis ............................................................ 24
5.12.6. Ironing or Low-contrast Skip .................................................................... 24
5.12.7. Gamma ............................................................................................. 25
5.12.8. Normalization ..................................................................................... 26
5.12.9. Contrast ............................................................................................ 26
5.12.10. Contrast Method .................................................................................26
5.13. Viewing Data .........................................................................................27
5.13.1. Heads-Up Data and Visual Display ..............................................................27
5.14. Export Scratch Data Chart Image .................................................................28
5.15. Export Processed Scratch Image .................................................................. 29
5.16. Export Scanned Scratch Region Image ........................................................... 30
5.17. Saving and Opening Projects ...................................................................... 30



Surface Machine Systems

3

5.17.1. Saving a Project ...................................................................................30
5.17.2. Save a Copy of a Project ........................................................................ 30
5.17.3. Opening a Saved Project ........................................................................ 30
6. Troubleshooting ....................................................................................... 31
6.1. Scratch could not be analyzed, or an Out of Memory Error occurs ........................... 31
6.2. Reported onset of scratch does not match or is insensible .................................... 31
6.3. Some of your parameters may be 0 or negative… ............................................... 31
6.4. Standard Deviation is very high .................................................................... 31
6.5. The scratch region is very wide or it is difficult to find the center .......................... 32
6.6. Data files from Kato Tech Co. take a long time to load ........................................32



Surface Machine Systems

4

1. About This Document
This document covers the operation and use of the SMS Tribometrics Software 2.3.22.0409. This document

does not cover analytical techniques or basic scratch or tribology science. For other documentation on these or

related subjects, see our website at:

http://www.surfacemachines.com

For additional information, or the latest software and manuals for your Scratch 4 Machine, you may contact

Surface Machine Systems at:

http://www.surfacemachines.com/swdist

This website will have our latest software, manuals, and contact information for support.

1.1. Conventions

When referring to interface elements of the software, we try to include images of the software interface as it

would appear. The elements you will be interacting with at any time will be marked with a red box.

Critical notes will appear in Red Boxes.

Notational items or warnings will appear in Yellow Boxes.

1. Ordered items,

2. For which the order is important,

3. Are numbered as such

► Items which have no order have bullets.

► Bullets are used to make lists of items with no particular order.

All references appear as such: a reference. If your format supports them, references are links.

http://www.surfacemachines.com
http://www.surfacemachines.com/swdist
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2. Introduction
The SMS Tribometrics Software version 2.3.22.0409 is the latest version of our visual analytic tool. This tool

can be used to assist in competitive analysis of certain types of visual criteria for ASTM and ISO scratches, and

certain types of mar behavior. The primary purpose of this tool is to discover the onset of whitening, as a result

of damage to a polymer specimen using the Scratch 4, 5, 5.5, or 5.6 Machine. While this software may be used

for certain other types of analysis, performance is not guaranteed.

2.1. Software Features

Capture From Scanner – you can import specimen images directly from your scanner.

Correlate Scratch Data – the software automatically correlates in situ scratch data with visible scratch

phenomena using built-in “heads up” analysis tools.

Load SMS Scratch 3.5, 4, 5, 5.5, and 5.6 Data Files – the software can read and understand data files

created by the SMS Scratch 4, 5, 5.5, and 5.6 Machine and some of the legacy TAMU 3.5 Scratch Machines.

Load Kato Tech Co. Data Files – the software can read and understand data files created by the Kato Tech

Co. Scratch Machine.

Store Multiple Scratches Per Project – a project keeps all your scratch scan and analysis bundled with

multiple scratch data files for easy retention.

Strict and Relaxed Analysis – relaxed analysis now helps to visualize very noisy scratch inputs without

compromising basic analytical analysis.

Parameterized Analysis – the important parameters of analysis are available to the user to help in custom

analytical processes.

Gamma Correction – the software correctly interprets color information.
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2.2. Automatic Scratch Visualization Overview

The Tribometrics software attempts to be an easy, quick tool for importing and completing scratch visual

analysis procedures in a consistent manner. Many of the tasks involved in performing visual analysis can be

done more reliably and faster with the tool than with traditional manual methods. Additionally, the software is

internally consistent, which is a critical criterion for performing competitive analysis between different

materials. The same “eyes” are now looking at your visual data, rather than trying to rely on lab procedures and

staff training.

The software is implemented such that its interface is in “procedure order”. By following the layout of the

software, any user can be taught to very quickly identify and analyze samples. Additionally, all files

associated with the analytical process—the source image, data files, and analysis—are stored in a single

convenient format file.

2.3. Hardware Requirements

The following is a list of hardware requirements necessary to use the ASV Software.

Security Dongle – a USB security dongle as provided by SMS is required to operate the software. You can

acquire these from Surface Machine Systems.

Photo Scanner – a photo scanner capable of at least 1200 x 1200 DPI (47 x 47 DPmm) optical scanning is

required. Be careful to check that the scanner supports an optical zoom, rather than software interpolation. For

operation with the ASV Software, the scanner must support Windows Image Acquisition.

Color Correction Card – a supported Color Correction Card. These can be acquired from Surface Machine

Systems.

Windows PC – A Windows PC running Windows XP SP3, Vista SP1, Windows 8, 10, or 11 with

Microsoft .NET 4.6.1 is required.
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3. Parts Description
The Tribometrics Software is downloaded from https://surfacemachines.com and requires a USB hardware

dongle.

https://surfacemachines.com
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4. Installing the Software

4.1. Installation Requirements

The following software packages are required to use the Scratch 4 Machine:

► The Tribometrics, downloaded at:

► https://surfacemachines.com

► Microsoft Windows XP SP3, Windows Vista SP1, 8, 10, or 11

► Microsoft .NET 4.6.1

4.2. Installation Directions

1. Double-click on the file “Tribometrics.2.3.22.0409.msi”

2. When you see the following screen, click “Next”.

3. Choose your installation directory, and click “Next”. If you are unsure about this, leave the default.

https://surfacemachines.com
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4. Click “Next” on the following screen, then click “Next” on this screen.
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5. Using the Tribometrics Software

5.1. Starting the Software

1. Select the “Tribometrics” button from the Start Menu, or double-click the icon on your desktop.

5.2. The Main Interface

When you open the ASV Software, you will be presented with the following window.

This is the “Main Control Window”, and all major functionality can be accessed from this window.
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5.2.1. Primary Features

File Menu – this menu allows you to open and save Scratch Analysis Projects, and to save Scratch Scans

acquired within the software.

Tools Menu – this menu contains access to the analytical tools, and configuration and calibration tools. The

Scratch Data Viewer is also available from this menu.

Options Menu – this menu allows you to control aspects of scratch analysis and gamma correction.

Scratch Project – this area of the Main Window allows you to select a source specimen scan or acquire a

scan, and to configure color calibration.

Scratch Analysis – this area of the Main Window allows you to set analytical settings, and reports analysis

results.

Scratch Details – this area of the Main Window allows you to define scratches in the specimen scan, load

scratch data for each scratch in the specimen scan, and to perform the analysis itself.

5.3. Overview of Operation

The high-level process of visual analysis is as follows:

1. Acquire an image or scan of the specimen at 300 x 300 DPI (11.8 x 11.8 DPmm), along with the color

correction card.

2. Load the image into the Tribometrics software.

3. Select and set the color calibration card in the scan.

4. For each scratch on the specimen, identify the location of the scratch in scan, and load the corresponding

scratch data from file.

5. Choose analytical settings.

6. Perform analysis.
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5.4. Acquiring a Specimen Image

The Tribometrics software requires an image in TIFF, BMP, or PNG format for analysis. This image can be

scanned by using the scanner software included with your scanner, or the built-in acquisition software in the

Tribometrics software. There are two ways to load an image of the scan into the Tribometrics – open an

existing image from disk, or use the built-in scan acquisition.

5.4.1. Open An Existing Image

To open an existing image saved to your disk, follow these directions.

All specimen images used by the ASV Software must be at exactly 300 x 300 DPI (11.8 x 11.8 DPmm)
resolution. Use of other resolutions will result in failed or incorrect analysis.

1. In the Main Window, in the Scratch Project section at the top, click “Load Existing Image”.

2. Browse to the location of your specimen image scan on disk.

3. Select the image.

4. Click “Open”.

5. The specimen image scan will be automatically loaded into the Image Display area of the Main Window.

5.4.2. Acquire an Image from a scanner

When you perform a scratch, each scratch should be at least 4mm apart, but no less than 1 diameter
apart. For 1mm styli, leave 4mm between scratches. For 10mm barrel styli, leave 10-15mm between
scratches. You should place no marks of any kind within 4mm or 1 diameter of the scratch or mar.
Marks within this region can distort the results of analysis, or make analysis impossible.

1. Make sure your scanner is plugged into the computer and powered on.

2. In the Main Window, in the Scratch Project section at the top, click “Scan New Image”. A window similar

to the following will appear.
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3. Select your scanner from the list, and click “OK”. The following window appears.

4. Click the link at the bottom “Adjust the quality of the scanned picture”.
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5. In the field “Resolution (DPI)”, enter the value 300. Click “OK”.

6. Place the specimen on the scanner, along with the Color Correction Card. The color correction card should

be placed near to the specimen, but not underneath or on top of it. The specimen should be arranged such

that the traversal of the scanning element runs “down” the scratches as follows, or transverse. Mixing

perpendicular and transverse scans is a procedural error.

Scanning element

Scan direction

Color Card

Specimen



Surface Machine Systems

15

7. Click the “Preview” button. The software will automatically try to detect the specimen in the scan. You

can use the white squire “handles” in the preview image to select the desired scan region. If a scratch is

near the edge of the specimen, choose a region slightly larger than the specimen – you will need at least

4mm, but no less than 1 stylus diameter of space around each scratch.

8. Click the “Scan” button.

9. The scan will be loaded in the ASV software automatically.
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5.5. Sizing Images

If you acquired the image from a source for which the 300 x 300 dpi resolution cannot be guaranteed, you

should resize the image. To do so follow these steps:

1. When acquiring the image, make sure a high quality metric (millimeter) scale is included with the image.

2. Import the image using the “Load Existing Image” button.

3. Choose the length of scale you wish to indicate – this should be any length less than or equal to the length

of the scale.

4. Enter the length in the text box below the text “Locate Scale” in mm.

5. Click the “Locate Scale” button.

6. Click and drag the scale marker across the length of the scale as accurately as possible. The longer the

scale, the more accurate the resizing.
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7. Click the “Scale Image” button.

5.6. Configuring Specimen Color Calibration

Because every scanner varies slightly due to manufacture, each scan must be color calibrated to ensure that

analysis is consistent between samples.

1. In the Main Window, click “Locate Color Card.”

2. In the Image Display, drag the color card location tool across the image, lining up the color boxes with the

color boxes in the image. Each color box should be completely contained within the corresponding color

card box. You may use the four green circular handles to warp or shift the box to match.
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3. Click the “Set Color Card” button.

5.7. Creating a Scratch Profile

Each physical scratch on the specimen should have a Scratch Profile saved in the project. Tribometrics must be

told the location of a given scratch within the specimen scan. This scratch location is called the visual

specimen. Each scratch should also have a scratch data file associated with it. Additionally, several parameters

must be recorded for a scratch, including:

► A unique name for the scratch

► Tip diameter in mm

► Scratch length in mm

► The velocity of the scratch in mm/s

► The data capture rate of the scratch

To add a Scratch Profile to the Scratch Project, follows these steps:

1. Click “New Mark”
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2. Optionally click the “Set Source Directory” button marked with the ellipsis – “…”. This will attempt to

automatically find data files that match the name of the scratch or mark you enter.

3. Enter the name of scratch or mark in the “Mark Name” field.

4. If the related scratch data file is not found, click “Choose Data” and find the associated data file.

5. If the size, velocity, length, or data rate are not loaded or are incorrect, set those parameters.

6. Click the button “Locate Scratch” under the label “Locate Scratch in Image”. In the Image Display area,

find the end of your scratch. This should be identified by a round “indenter mark”. Click the left mouse

button in the center of this mark, and drag the mouse along the path of the scratch. A pink line will

indicate the path of your selection. Try to keep this line within the center of the scratch. Although the

line does not have to cover the entirety of the scratch, the more you select, the more accurately the software

can identify the scratch.
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7. Click button “Save Mark”. The Mark Name of this Scratch Profile will now appear in the Scratch Profile

List.

8. To create additional Scratch Profiles, go back to Step 1.

5.8. Reviewing Scratch Profiles

You can review a Scratch Profile at any time by selecting the appropriate Scratch Profile from the scratch list

box at the top of the Scratch Details area. Selecting the Scratch Profile will automatically load the scratch

information and file as the present scratch.

You can view the scratch data in for the Scratch Profile currently selected by clicking the button labeled “View

Analysis”. This will open the Scratch Data Viewer window to display the data.



Surface Machine Systems

21

5.9. Updating Scratch Profiles

You can update a Scratch Profile by selecting the Scratch Profile, and then updating its values in the Scratch

Details area. Save changes by clicking the “Save Scratch” button below.

5.10. Delete a Scratch Profile

1. Select the Scratch Profile from the list.

2. Click the “Delete” button.

5.11. Setting Scratch Analysis Parameters

The defaults for the parameters are 3 for “Contrast (%)” and 90 for “Continuity (%)”. The defaults are

appropriate for most analysis.

5.12. Analyzing a Scratch Specimen

To analyze the scratch specimen, follow these steps:

1. Create Scratch Profiles for each scratch in the specimen (see section 5.7).

2. Save your Scratch Project by clicking “File”, “Save Project”. Type the name of the project in the “File

name:” field, and select the output directory you would like it stored in. Click the button labeled “Save”.

3. Click the button labeled “Analyze Marks”. The interface will pause for some time (a minute or more in

some cases), and a window similar to the following will appear.

4. Press “OK”. If there are any problems in analyzing your specimen, you should receive a warning, and the

number of scratches analyzed will be less than the number of Scratch Profiles you created.
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5. Below the “Analyze Marks” button, a summary of the analysis from the data files is displayed. This

summary shows the onset of whitening in mm (distance) and Newtons (load) for the presently selected

Scratch Profile. It also displays the mean onset of whitening for all Scratch Profiles and the corresponding

standard deviation from the mean.

6. You can view the analysis of each scratch by clicking the “View Analysis” button for each selected Scratch

Profile. Once analysis is performed, this button will open two windows: the Scratch Data Viewer and the

Scratch Image Viewer.

5.12.1. Analysis Options

Some scratches have very noises damage profiles which can cause the analysis to find the “end of scratch”

earlier than expected. In the image below, the software has identified the beginning and end of the scratch by

green lines. The “whitening” area is highlighted in Red. The onset of scratch is indicated by the light blue line

at the right of the scratch image. Clearly, this is too late in the scratch. Because of the dark regions between

the whitening areas (highlighted in red), the software read a false positive for the end of scratch. These kind of

false positives can usually be overcome by using “Relaxed Analysis”. Relaxed analysis allows the software to

“skip” over false end-of-scratch readings, and has little or no effect on the resulting analysis when compared to

scratches which do not require this option.

To enable relaxed analysis, follow these steps.

1. In the “Options” menu, select “Relaxed Analysis”.

2. The option “Relax (%)” will become enabled in the section “Scratch Analysis”.
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3. For very “noisy” scratches (such as the one above), set this field to a low value, such as 50. For relatively

solid scratches, use a high value, such as 80. A value at or above the “Continuity (%)” value will have no

effect.

4. Click the “Analyze Scratches” button again. The new analysis will now be presented.

5.12.2. Proportional Visibility Scratch Analysis

For constant-load mar testing (similar to Taber testing), use the “Scratch Contrast Visibility Index” option. This

option reports the proportion of the scratch that exceeds the contrast threshold set in the “Contrast (%)”

parameter.

To use Scratch Contrast Visibility Index, follow these steps.

1. Click “Options”, “Specialized”, “Mar Contrast Visibility Index”.

5.12.3. Ford 5-Finger Gauge

For assessing visibility for multiple constant-load tests, you may use the Ford 5-Finger Gauge. This analysis

reports the millimeters of visible damage (exceeding the Contrast criterion) for each mark. You must determine

your own procedure or metric for the definition of visibility. For instance, for a 150mm mark, you may require

a threshold of 20mm to be viewable to be considered viewable.
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To use Ford 5-Finger Gauge, follow these steps.

1. Click “Options”, “Specialized”, “Ford 5-Finger Gauge”.

5.12.4. Mar

For some very wide stylus geometry, it can be difficult to find the center of the scratch. Additionally, these

stylus produce a very wide path for analysis, which may require a larger background area for contrast

comparison. Mar analysis addresses this issue using the Mar analysis option. In the mar analysis mode, the

center of the scratch is not selected. Instead, the top or left side of the mar is selected.

To use Mar analysis, follow these steps.

1. Click “Options”, “Analysis Method”, “Mar (Barrel)”.

5.12.5. Proportional Visibility Mar Analysis

For constant-load mar testing (similar to crockmeter testing), use the “Mar Contrast Visibility Index” option.

This option reports the proportion of the mar region that exceeds the contrast threshold set in the “Contrast (%)”

parameter.

To use Mar Contrast Visibility Index, follow these steps.

1. Click “Options”, “Analysis Method”, “Mar Contrast Visibility Index”.

5.12.6. Ironing or Low-contrast Skip

In some cases, geometric or other effects of the plaque will cause the scratch to fail early in a way in which

Relaxed Analysis cannot overcome. For instance, in the scratch below, it is clear that end of scratch marker

(green line in the center of the processed image) is not the beginning of the scratch. This is a result of large

ironing region with decreased contrast. To overcome this, you can use the “Assist” option. The “Assist” option

is available in the Scratch Image Viewer (displayed below).
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To use the Assist option, follow these steps.

1. In the Scratch Image Viewer, click “Assist”, then “Start Analysis From …” A pink line will be visible in

the processed region.

2. Click on the contiguous segment nearest the beginning of the scratch. This will mark the processed image

with a pink marker line.

3. Close the Scratch Image Viewer, and run the Analysis again.

4. The onset of scratch is now found prior to the marker in the scratch region.

5.12.7. Gamma

For most Windows PCs and scanners, the Gamma should be set appropriately. Some scanners may use an

alternate gamma of 1.8. Check the documentation for your scanner. The gamma must be adjusted prior to

analysis. If so, the gamma may be adjust by these steps.
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1. Click “Options”, “Set Gamma”, “Gamma 1.80”.

5.12.8. Normalization

Normalization is the method by which the color space of the scratch scan is corrected. The software defaults to

“2-Point” normalization. If your analysis seems to dark (that is, not enough of the scanned region is marked as

high-contrast), try switching the normalization to “Single Point”.

When performing analysis between different specimens for comparison, they must all use the same
analytical settings. Do not compare results between samples analyzed with different Normalization
options.

1. Click “Options”, “Normalization”, “Single Point”.

5.12.9. Contrast

By default, the analysis only looks for contrast in the scratch which is higher than background. This is

appropriate for black samples, or very high-gloss or chrome samples. For lighter samples, the settings “Low” or

“Both” should be used. The “Low” setting only considered contrast which is darker than the sample (generally,

ironing effects and shadows). The “Both” setting is appropriate if you are considering the most aggressive

possible definition of visibility. To adjust this setting follow these steps.

1. Click “Options”, “Contrast Option”, “Both”.

5.12.10. Contrast Method

By default, the analysis finds foreground objects using “simple” or trivial, absolute-scale contrast testing. For a

color space [0.0 … 1.0], if the background is  (say, 0.1), and the contrast criterion is  (say 3% or 0.03), then

a foreground object is “of interest” if it’s value  >=  + . This is the simple contrast method, and is set by

following these steps.

1. Click “Options”, “Contrast Method”, “Simple”.

A more aggressive method of analysis is Weber contrast, which finds relative changes in contrast in the

specimen. This analysis is recommended for very smooth plaques, or for mar analysis. For foreground

luminosity IF and background luminosity IB, it is defined as:
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B

BF

I
II 

This contrast method can be chosen by following these steps.

1. Click “Options”, “Contrast Method”, “Weber”.

5.13. Viewing Data

Once analysis is performed on your specimen, the ASV offers powerful tools for viewing and recording your

analysis.

5.13.1. Heads-Up Data and Visual Display

The ASV provides the facility for you to correlate scratch data with visual phenomena in real-time. This

functionality is available via the comparator tool. This tool is turned on by default when you open the Scratch

Profile results after an analysis. In the image below, the comparator tool can be seen as the vertical black line

in the Scratch Data Viewer window, and the corresponding white vertical line in the Scratch Image Viewer. As

your mouse traverses either the scratch data in the Scratch Data Viewer, or the scratch image in the Scratch

Image Viewer, the corresponding Comparator line moves in the opposite window.
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To use the comparator, follow these steps after analysis.

1. In the Main Window, in the Scratch Details section, click the button labeled “View Results”.

2. Hover your mouse over an area of interest in either the Scratch Data Viewer window or the Scratch Image

Viewer Window. A line will follow your mouse in this window. A corresponding line will appear in the

opposite window, and traverse this window along with your mouse in real time. You can read the scratch

data from the Scratch Data Viewer window in the “Chart Data” section.

5.14. Export Scratch Data Chart Image

You can save the Scratch Data Chart as an image to disk. Follow these steps to do so.

1. In the Main Window, click the “View Results” button.

2. The Scratch Data Viewer and Scratch Image Viewer windows will open.

3. Resize the Scratch Data Viewer (and chart) to whatever size is appropriate.

4. Select the Chart Data you would like to have exported to image.



Surface Machine Systems

29

5. Uncheck the box next to “Comparator”.

6. Right click on the main Chart Area.

7. In the context menu, click “Save Image As…” A Save File dialog will open.

8. Choose the output directory and give your image a name.

9. In the “Save as type:” drop down, select “PNG format (*.png)” or “Jpeg format (*.jpg)” or “Bmp format

(*.bmp)”.

10. Click the “Save” button.

5.15. Export Processed Scratch Image

To save the scratch image with the processed areas highlighted (the top scratch image), follow these steps.

1. In the Main Window, click the “View Results” button.

2. In the Scratch Image Viewer window, click “Save”, “Save Processed”.

3. In the Save File dialog, give the processed scratch image a name, and select the output directory.

4. Click “Save”.
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5.16. Export Scanned Scratch Region Image

To save the scratch image from the specimen scan, follow these steps.

5. In the Main Window, click the “View Results” button.

6. In the Scratch Image Viewer window, click “Save”, “Save Scratch Region”.

7. In the Save File dialog, give the scratch image region a name, and select the output directory.

8. Click “Save”.

5.17. Saving and Opening Projects

5.17.1. Saving a Project

1. Click the “File” menu, then “Save Project”. A Save File dialog box will open.

2. Give the project a name, and choose the directory your project will be saved in.

3. Click “Save”.

If you project has already been saved, then clicking the “Save Project” button will cause the software
to update the saved project on disk rather than opening the dialog box.

5.17.2. Save a Copy of a Project

1. Click the “File” menu, then “Save Project”. A Save File dialog box will open.

2. Give the project a name, and choose the directory your project will be saved in.

3. Click “Save”.

5.17.3. Opening a Saved Project

1. Click the “File” menu, then “Open Project”. A Open File dialog box will open.

2. Navigate to the directory containing your project.

3. Select your project.

4. Click the button labeled “Open”.
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6. Troubleshooting

6.1. Scratch could not be analyzed, or an Out of Memory

Error occurs

Scan is Clipped

It may be that the specimen scan is clipped to close to the sides, beginning, or end of the scratch. Increase the

scan size of the specimen.

Wrong Scratch Length is Entered

Check the scratch length entered into the Scratch Profile. A scratch length which is too long for the scratch

may cause an error.

Scan is at the wrong resolution

Make sure you have scanned the image at exactly 300 x 300 DPI (11.8 x 11.8 DPmm).

6.2. Reported onset of scratch does not match or is

insensible

Scan is at the wrong resolution

Make sure you have scanned the image at exactly 300 x 300 DPI (11.8 x 11.8 DPmm).

6.3. Some of your parameters may be 0 or negative…

Check the “Tip Dia (mm)” field.

6.4. Standard Deviation is very high

Try using “Relaxed Analysis”.
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1. Click “Options”, “Relaxed Analysis”.

2. Click “Analyze Scratches”.

Try using the “Assist” option from the Scratch Image Viewer.

1. For each scratch, click “View Results”.

2. Click “Assist”, “Start Analysis From …”

3. Select the last contiguous scratch region marked in the processed region.

4. Re-run analysis

6.5. The scratch region is very wide or it is difficult to find

the center

Try using Mar Analysis. Mar Analysis requires you to select the top or left edge of the scratch.

1. Re-select your scratches using the top or left edge of the scratch.

2. Click “Options”, “Analysis Method”, “Mar (Barrel)”

6.6. Data files from Kato Tech Co. take a long time to load

This is a result of Microsoft’s public import routines. This is expected behavior.
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